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Chapter 1 – Application Overview 

Welcome to Tax-Mate 1500 
Welcome to the File-Mate 1500 Health Insurance Claim Form compliance application. 
File-Mate 1550 is designed to help you easily and effectively manage the reporting your HCFA or CMS 
1500 information. 
 
File-Mate 1500 is a tool to organize and print your data for the Health Insurance Claim Form 1500 that 
health care providers must submit for payment of services. File-Mate 1500 is database application. As 
you enter data the program automatically saves and arranges the data to fit the 1500 form. We have 
organized it so that you can easily click tabs and buttons to move within a specific patients’ 1500 form. 
When you need to edit, no need to scroll through the document, just click the tab where the 
information you need to change is located and update your data. 
 
  



The Home Page 
The Home page is the starting point for working within File-Mate. Here you will find a list of the Patients, 
Providers, Carriers and Forms that have been entered. Clicking on a Patient will review the forms that 
have been entered for that patient. Clicking the form will open the edit view for that form; this is how 
you would edit the content of a form, more on this later.  
 

 

The Flow 
Let’s just take a minute to talk about how to use the program. In general we have an idea of how we 
think the end user will use the program. We also realize that not everyone does things the same so we 
have tried to make software flexible. This is concept is best explain in the task of creating a new form, 
you can either create the Patient first, then create the form; or you can create the form, then create a 
new patient with the form, either way, you will end of at the same point, entering the details of the 
form. So don’t be afraid to dive in, the data is saved automatically and everything can be undone. 
 
  



The Tabs 
The tabs on the Home Page are the main source for viewing information within the File-Mate 1500 
application. Each tab contains a different section the information, Patients and Insured in the first tab, 
then Providers and so on. Following is an explanation of each tab. 
 

 
 
 
Patient tab – This is the main display of the Patients that have been entered into the program, each 
Patient only need to be entered once, then can be used on multiple forms. If you change information for 
a Patient, that change will appear on all the forms for that Patient. 
 
The Patient list can be sorted using the underlined headers; those include last and first name, address, 
account number and their phone number.  
 
There is also a find feature built into the Patient list, enter the word or words that you are looking for 
and press the “Find” button. 
 
You can edit this list by clicking on the “Edit List” underlined word button in the upper right corner of the 
list, by doing so, you will see a hidden set of tools that allow you to select or clear the selected 
checkbox’s, then once you have made your selection you can delete the selected items. Click the “Done” 
button when you are finished. 
 
The other list found in the Patient tab is the Form list; this list will show only the forms that are attached 
to the selected Patient. 
 
The Form list also have has an edit list feature that allow you to delete or archive the forms in a similar 
manner as the Patient edit feature. 
 
Provider tab – Here is a list of both the Providers and the Referring Physicians that have been entered 
into the system. 
 
The Provider list also has an Edit List feature to delete entered Providers and Referring Physicians. 
 
Similar to the Patient list, the Provider list also has a Form list to show the forms that are associated with 
the above select Provider. 
 
Carrier tab – Here is a list of the Carrier that have been entered into the system. 
 
The Carrier list also has an Edit List feature to delete entered Carriers. 
 
Similar to the Patient list, the Carrier list also has a Form list to show the forms that are associated with 
the above select Carrier. 
 
 



Form tab – Here you will find two additional tab; the Open and Archive.  
 
The Open list will show a list of all of the forms entered into the database. This list can be useful to find 
lost or orphaned forms that don’t have an active Patient, or is just useful to view all the forms in one 
place.  
 
The Archive list is the only place to view forms that have been archived. You can view archive data as a 
1500 form preview, you can also print this form if needed, but you cannot edit this data as an archive. If 
you need to edit a particular form, you will need to un-archive the data, making it an active form. 
 
Note that archive data are not effective by the current information, so for instance, if you archive a form 
with a current address, then change that address in the same Patient record, the archive file will retain 
the older original address. 
 

The Menus 
The File-Mate 1500 application has menus that will appear at the top of the screen, while these menus 
may change depending where you are in the software, you will always have some kind of menu. Often 
the tasks in the menu will be duplicated in the program, if this is the case, feel free to use either the 
button or menu to accomplish the task you desire. 

 

File Menu 
New > Patient (Ctrl-N) – Create a new Patient record, each Patient only need to entered once, editing a 
Patient record will update that information on all the forms that are attached to that Patient. You can 
also use the “New Patient” button found on the Home Page, or the “New” button in the Patient and 
insured tab of the form. 

New > Provider – Select this menu item to create a new Provider record. Just like the Patient record, 
each Provider only needs to be entered once, and then attached to a form to display and print the 
information. You can also use the “New Provider” button on the Home Page, or the “New” button in the 
Provider section found under the Provider tab in the edit view. 

New > Carrier - Select this menu item to create a new Carrier record. Just like the Patient and Provider 
record, each Carrier only needs to be entered once, and then attached to a form to display and print the 
information. You can also use the “New Carrier” button on the Home Page, or the “New” button in the 
Carrier section found under the Provider tab in the edit view. 

Codes – Selecting this item will display the Coder dialog box. This is where you view and enter CPT and 
ICD codes to use with the program. This can be very helpful having the codes pre-entered. Along with 
the codes you can enter additional information such as modifiers, units and pricing. 



Import – Selecting this menu item will display the Import dialog box. See the Import and Export section 
of this guide for more information. 

Export - Selecting this menu item will display the Export dialog box. See the Import and Export section of 
this guide for more information. 

Print Setup – This allows you to access the Windows or Macintosh specific information for printing. This 
dialog allows you to set things like default printers, print orientation, paper size, etc. 

Print (when editing a form) – This opens the Print dialog to allow for printing. See the Printing section in 
the guide for more information on printing. 

 

Edit Menu 
Undo – This will come and go depending on what the last action was, if it is undoable, it will show Undo, 
if not, it will something like “Can’t Undo”. Most typing actions are undoable, and many button clicks are 
not. There is also a “Redo”, this will redo the undo.  

Cut, Copy Past and Clear – This is a group of menu items, most of us have a pretty good understanding 
of these items so I won’t go over them here. If you need a refresher, I’m Google can handle this one. 

Find and Replace – This is useful on large text block where you need to find a word and replace it with 
something else, but does not work across multiple fields. Kind of limiting, but thought it might be useful 
for some. 

Spelling – Allows you to edit the dictionary for the spelling feature. Could be used for Spanish if need, 
otherwise most folks will not need to mess with this sub-menu. 

Preferences – Here again we have a whole set of controls that general left alone unless you talking with 
tech support. 

 

View Menu 
Home – Click this menu item and it will take you to the Home page. 

Patient – Click this menu item to view the Patient and Insure tab in the detail view. 

Provider, Service and Form - Similar to the Patient menu item, but will show the item corresponding to 
the title. 

Zoom In/Zoom Out – File-Mate has a feature to allow you to expand or shrink the view of the program. 
This can be useful if you have a large monitor and need to enlarge the contents. If you are ever unsure 
of you current zoon level, in the lower left corner of the application you can view the current level. The 
“+” and “-“ buttons to the right of the zoon level will also work in the same manner as the similar menu 
items. 



 

Form Menu 
New – Creates a new form. 

Delete – Delete the current form. 

Archive – This will convert the current form to an archive. For more info on Archives, see the Archive 
section. 

Help Menu 
User Guide – Display this document from the current copy of our web site, www.formmagic.com. 

Registration – Opens the Registration dialog, from here you can add a new registration number, remove 
the current number so you can add a new number. If you have a number entered, this dialog will show 
you the expiration date of that number. 

File-Mate Web Page – Open the current File-Mate 1500 product page. 

Remote Support – This will open an external helper application that will allow Form Magic Tech Support 
to view and manipulate your local screen. But don’t worry this feature requires that you read the 
number given by the application to tech support before they can log onto your screen, so we can’t 
access your machine without your permission. 

About File-Mate – This dialog will show you the current version that you are running. 

 

  



Chapter 2 – 1500 Form 
 

1500 Form 
The 1500 form is whole reason that you purchase this software, so let’s take a minute and talk about 
how to create, edit and print the form. 

 

There are a few ways to create a new form, clicking on the “New Form” button from either the Home 
Page or the Detail View, or clicking on the “New” menu item under the Form menu are probably the 
most convenient.  In its original state, the new form that you created does not belong to a Patient, or a 
Provider, or even a Carrier. If you create a new form, and then go back to the Hope Page you will get an 
error like this; 



 

This is done to avoid creating forms that have no attachment to a Patient, since the Patient is the 
primary way of groping forms.  

So, the first thing that you will want to do after creating a form is to assign a Patient to the form. You do 
this clicking on the “Patient and Insured Index” button under the Patient and Insured tab of the detail 
view, and choose an existing Patient from the list. Click the “Choose” button to attach the Patient. Or, 
you can create a new Patient by clicking the “New” button under that same tab. Note, that the “New” 
button only appears if no Patient has been assigned, otherwise the button will display as an “Edit” 
button to allow you edit the current Patient. Use the “Clear” button to un-attach a Patient from a form. 

Shortcut - There is also a quicker way to create a new form and assign a Patient at the same time. 
Within the Patient list found on the Home Page, you will see a green “+ ” button on the right side of the 
list, press this button to create a new for with the Patient from that line automatically inserted as the 
Patient. 

Detail View Tabs 
When you click on a form in either the list under the Patients, or in the Open list under the Form tab, 
you will see the form information display in what we call the Detail View, this view is broken down into 4 
tabs; Patient and Insured, Provider, Services and Form. The reason we divided the form is to simply 
present in a human readable fashion, with like items in the same place. 

Patient and Insured tab – This is where you attach the form to a patient by selecting from the Patient 
and Insured index. You can also create a new patient at this point by clicking the “New” button. 

Provider tab – This is where you attach an existing Provider to the form, and as with the Patient section, 
you can also create a new Provider here as well. You will also see the Referring Physician section here 
with the Provider; since they share many traits with the Providers it made sense to display them here. 

The Carrier information is also contain under the Provider tab, we tend to think of the term provider as a 
broad term for the persons or agencies that provide services to the patient, or provide payment for the 
service. 



Form tab – Here you will find the form as it appears on the actual CMS 1500 form, some folks prefer this 
form for enter data, other might find it convenient to find that seldom used item. 

Attaching Patients, Providers and Carriers 
As we said earlier, the form itself does not contain all of the information that is required when it is newly 
created, to complete the form; you need to attach Patients, Provider, Referring Physicians and Carriers. 
All of these bits of information work in the same way, so we thought we’d talk a bit about how to do this 
attaching, clearing and creating new entities. 

Attaching – If the information element already exists, i.e. the Patient has been entered into the 
database; they will be listed in the Index. So, to attach a Patient, click on the “Patient and Insured Index” 
button, then from the list select the Patient and click the “Choose” button.  

Clearing – If you have a Patient attached to a form, but wish to remove that Patient, click the “Clear” 
button to de-attach the Patient. 

New – If there is not a Patient attached to the form, then you will have the option of clicking the “New” 
button to create a new Patient, after saving the Patient, they will be automatically be attached to the 
form. 

Edit – If there is a Patient attached to a form, the “New” button will display as an “Edit” button. Clicking 
this button will allow you to change the current Patient. 

Entering Codes and Procedures 
Both the Diagnosis (ICD) codes and Procedure codes (CPT) are initially entered in the Codes dialog box 
found under the File menu by clicking the Code menu. Once entered, you can attach the codes to the 
form under the Service tab in their respective sections, by clicking on the List button <list button> to the 
right of where you would type the code. The list button allows you to find a code by typing into the find 
box at the top of the list, or scroll through the list. Once you have found the code you are looking for, 
click on the code to add to the field.  

Dates and Labs 
Dates and labs is the catch all for some of the items on the 1500 form that are less used, but still need to 
be used on occasion. To access the Dates and Labs, click on the “Service” tab, then click the “Dates & 
Labs” tab. 

Form Info 
Common on each of the four tabs with the Detail View you will find a Info section in the lower left of the 
screen. This section contains information that is relevant the form, things like status, edit date and time, 
and charge and balance information. 

Archive – Use this button to save the current form to an archive record. 

Status – This is a user adjustable field designed to let you track the status of a form. You can add or 
change the status titles by clicking on the “Edit” button at the bottom of the list. 



Date and Time – Date and time of the last time the form was changed 

Total Charges – This is the total of the Procedures that are entered for the current form. 

Amount Paid – This is a non-form field that can used to record a payment by the patient. 

Adjustment – This is a non-form field that can be used to record after the fact payment to you the 
provider. 

Balance – This is the end result of the above fields, Total Charges minus Amount Paid minus Adjustment. 

Balance Age – This is the number of days since the form was created, this will only display if the form 
have a 

  



Chapter 3 – Printing 
If the form is the most important reason to use File-Mate 1500 application, then printing is the most 
important task. Once you have filled in all the information that is needed, you can access the Print dialog 
by clicking the “Print” button, or by selecting the Print menu item under the File menu. 

Print Style 
1500 Form – Prints a complete form, including lines, title and data to a plain sheet of paper. 

1500 Data – Print just the data to a pre-printed form. Forms can be purchased on our web site. 

Invoice – Print an invoice based on the Procedures listed on the form, the description for the invoice can 
be entered in the procedure list. 

Reports – Prints a Patient or a Procedure list report. You can also use the export feature to save your 
data in an Excel format. 

Print Range 
Current Form – Print the single form you are viewing. 

Current Patient – Print all the forms associated with the current Patient. 

Selected Forms – Prints all the forms that have the selected checkbox mark with an “X”. This can include 
forms from more than one Patient. Note that the selection checkbox can be found in the upper left 
corner of the Detail View, or the left side of the Patient list view, or the Open list on the Home Page. 

Date Range (Start/End) – Allows you to print forms with a data range of the start and end dates. 

Options 
Color – Allows you print a black or red copy of the 1500 form to a color printer when use the plain paper 
option. 

Output – The pre-printed version of the 1500 form has printed instructions on the back of the form; 
some payers require these instructions, so this option allows for the print of the back page instructions 
when using the plain paper option. 

Font – Allows for the selection of alternative fonts, works on both plain paper and pre-printed forms. 

Preview button – Opens a preview of the printed page. 

Print button – Opens either the Windows or Macintosh Print dialog. 

 

  



 Chapter 4 – Import and Export 
There are two ways to get data into the File-Mate 1500 application, the first is to type the data by hand, 
and the second is to import the data from a data file, typically this would be a spreadsheet such as an 
Excel file. The program accepts most of the common formats, with the tab delimited being the most 
common. The other common use of the Import and Export dialog is to create and load backup files. 

Import Data 
Backup File – This option loads the File-Mate 1500 (.fmc) file and loads the data. 

Data File – This option allow you to import data, you will need to define where that data is to be 
imported; choosing either Patient, Provider (and Referring Physician), Carrier, CPT, ICD or Combined. If 
you wish to view the fields that are available for import, go use the export feature to save some existing 
data and you will have a template for your import data. 

Rollover – Imports data from prior version of File-Mate 1500, supports version 4-6. 

Export Data 
Backup File – Saves a backup copy of the entire data as a compressed file. Typically this file is save as a 
(.fmc) file. 

Payment File – Saves what is called a Print Image file. This data type is the commonly accepted file for 
Clearing Houses and online entries for major Health Care Networks and Insurance companies. 

Data File – Allows you to save your data to an excel type spreadsheet, similar to the Import; you will 
have to define the type of output prior to saving. Output choices include; Patient, Provider (and 
Referring Physician), Carrier, CPT and ICD. 

 

  



Installer Guide 

Section A – Install and Update 
The File-Mate 1500 Installer is designed to both install the software onto a new computer, or update an 
existing File-Mate 1500 of the same version. In the case of version 7.5, it will update any of the 7.x 
versions of the software. 

Downloading the Installer 
There are separate installers for Windows and Macintosh Operating System, both installers are available 
on the www.FormMagic.com web site. There are minimums list on the web site for the Windows and 
Macintosh OS’s. If you are running an older version, please call tech support. 

Save the installer to your local hard drive before running the installer. 

Install 
Double click the installer application to start the install. 

1) When you see the File-Mate 1500 Welcome panel, click Next to continue. Agree and accept the 
Licensing agreement to continue with Next. 

2) In the Destination Location panel, choose the folder where you want to install File- Mate 1500. By 
default, File-Mate 1500 will be installed in the C:\ Program Files\File-Mate\FM7, or in the Applications 
folder on a Mac. If you want to install File-Mate 1500 in another folder or on another drive, click the 
drop down menu within the folder display and navigate to the folder where you want to install File-
Mate. If the selected disk doesn't have enough space for the files you select, or is write-protected, you 
can leave the installer and delete existing files to make more room on the disk. If the disk is locked, or 
isn't a hard disk, you can choose another drive. Click Next. 

3) In the Select Start Menu Folder window, select the name that you would to have display in your 
Windows Start menu. Default is File-Mate 1500. Click Next to continue. 

4) In the Select Additional Tasks window, you can choose to have a desktop icon and/or a quick launch 
icon created. Click Next to continue. 

5) The Summary window is a summary of your previous choices, examine the contents, if they are 
correct, click Install to begin the installation. 

6) When the installation is complete, click Finish. 

Running the Application the First Time 
The first time your File-Mate 1500 a couple of things will happen. First the application will decide if it is a 
new install, or a re-installer. If it is a re-install, it will attempt to load the data from the prior version. If 
the program is a new installer, but there are prior versions on the same computer, the program will 



attempt to find those older versions and import the data. You will be given a choice to accept this 
import, or pass in the import. If you choose to pass, you can manually import older data at a later time 
by selecting the Import dialog under the File menu, and then choose the Rollover option. 

Next, again if it is a re-install, it will attempt to load the registration number from the prior version. If it 
is a new install, you will be given the chance to enter your registration number, or click the “Demo” 
button to continue in demo mode. 

Updating an Existing Version 
As mentioned above, the File-mate 1500 installer can perform both new installs of the software, or an 
update of an existing version. The update can only be done on version with the same series as defined 
by the first number of the version. So, version 7.5 can update version 7.x, but not version 6.x. 

Uninstalling 
To uninstall on Windows, either use the uninstall tools found in the preferences, or click on the 
“Uninstall File-Mate 1500” link in the Start menu. 

To uninstall on a Macintosh, simple drag the folder that contain the main application to the trash. 

Moving Application to another Machine 
File-Mate 1500 is self-contain with the folder that holds the main application, so you can move the 
entire folder and its contents from one machine to another. This will move the program, the data and 
registration number. Or, if you prefer, you can perform a backup of the data, then install a new clean 
version of the new machine and import the data from the backup. 

 

Section B – Registration and Renewal 

Running the Installer the First Time 
As mentioned above, the first time you run the program after installing, you will be given the chance to 
enter a registration number. If you are re-installing, the program should auto-register with the number 
from the prior application. 

Buying a Renewal 
If you have purchased a new annual registration number, you will need to enter this number. From the 
Home Page, select the “Registration” from the Help menu. If there is an older number entered, click the 
“Unregister” button. Then repeat the process to open the registration dialog, this time you can enter the 
new number and click “Register” to set the number. 


